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Speedstack Version History  

Speedstack key product milestones 

(Detailed change history on following pages) 

2023 Structure Wizard Enhancements 

New Check Copper Coverage Percentage option 

Manufacturing Constraints / DRC Enhancements 

Material Library Filter / Search Enhancements - improved filtering system 
implemented for the Material Library, Add Material and Swap Material options 

Online Library – New On-Premise Mode with Download option uses the HTTPS 
protocol for downloading the complete set of material library files 

2022 New Structure View feature - Drag the stack up image to the left or use the new 
Show / Hide Structure View button to view a graphical representation of all 
structures on the stack up 

New Grid View feature - Grid View presents the current stack up in an editable 
data grid form to allow for easy editing of multiple materials from a single dialog 

Online Library - AGC now added to the Supplier Filter option 

Confidential Stamp Options added to the technical report   

New Snap Parameters and Calculate Structure feature 

2021 Material note enhancements.  Core and Flex Core materials have now been 
expanded to support 15 notes fields.  5 x Upper Copper Notes, 5 x Dielectric 
Notes, 5 x Lower Copper Notes 

New Drill Cap feature 

New Layer Name property added to the electrical / copper layer element of a 
material of Foils, Cores, Flex Cores, RCCs and Shields 

The number of Copper Finishing classes has increased from 4 to 20 

The All Losses plot y-axis and data series labelling has been improved 

New Apply Plating Colours toolbar option – automatically assign different colours 
to plated and un-plated copper layers 

Support for Shield materials 

FlexNet Publisher / FLEXlm v11.17.2.0 supported 

2020 Online Library - improved workflow aiding more rapid download of library files 

Online Library - new Filter by Frequency option  

Technical report - now possible to select all pages, a page range or an individual 
page 

The number of stack up columns available for drilling information has been 
increased from 6 to 11 

New Back Drill type supported 

16 new drill properties including five user-definable notes fields  
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Selectable plating thicknesses added under Finishing Options 

Enhanced Material Library and Virtual Material Stack Up Wizards with increased 
the layer count limit from 64 to 128 

2019 DRC Resin Check / Excess Resin DRC enhanced to offer better support for 
sequential build stack ups 

Convert To Core functions enhanced 

Technical report includes multiple new options to customise printed output 

Loss tangent fields added to library materials 

Set Dielectric Constant and Loss tangent either manually or automatic from library 

Virtual material mode supports loss tangent in laminates and soldermask 

Import export files updated for 3rd party interfaces to CAD / CAM 

Causal modeling extended to copper losses 

Four Additional Drill – Via fill types 

2018 Import and export for industry-standard IPC-2581 Rev B files  

Eight new coplanar structures added, requested specifically for flex and rigid-flex 
designs 

Online Library - new On-Premise Mode 

New Cannonball-Huray method added to Surface Roughness Compensation options 

Full insertion loss data per structure including roughness modeling methodology 

Insertion loss graphs and data in reports 

Rich copy / paste insertion loss data to / from Si9000e 

Export insertion loss projects to Si9000e 

2017 Online Library –  download the latest material libraries 

Net Class functionality – enhances functionality when used in conjunction with CAD 
constraints managers 

Enhanced alignment of flex materials – through addition of material attributes – eases 
visualisation of bikini build flex construction 

Proportional view – to investigate appeal of a “virtual cross section” view 

2016 Edit and change copper layer types without losing impedance structures, new 
structure validation options, added barcode output to bill of materials. 

2015 Exports to Cadence Allegro, Mentor Xpedition, Zuken CR-8000 and Ucamco 
Integr8tor. Copy groups of impedance structures to new Si8000m and Si9000e 
projects option. 

2014 Export to IPC2581 rev B, Support for Stacked laser vias, enhanced copy / paste 
material library properties, and all new material library wizard. 

 
For detailed changes – please read on: 
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Version 23.05.01 

Enhancements / changes / additions 
1. Check Copper Coverage Percentage option - 001-00-000914 

a. This new Tools menu option can be selected at any time to determine which 
electrical layers, if any, have a Copper Coverage Percentage of 0.  This option is 
useful for users that select the Proportional to Coverage Finishing method, which 
relies on each electrical layer having the Copper Coverage % property populated 

2. Virtual Material Wizard Improvements 
a. When the Symmetrical mode is selected, the Solder Mask Bottom checkbox now 

matches Solder Mask Top when the checkbox is selected - 001-00-000915  
b. Under the wizard, Define Sequential Build, the colour of the core dielectric is now 

set to the Core Dielectric colour as defined under the Tools | Options | Colours.  
Previously, the core dielectric was set to the Speedstack default colour - 001-00-
000896   

3. Online Library.  Rename supplier from Showa Denko to Resonac 
 

 
Version 23.04.02 

Enhancements / changes / additions 
1. Manufacturing Constraints / DRC Enhancements - 001-00-000914 

a. The Active Constraint name is now shown on both the DRC tab and 
Manufacturing Constraints dialog 

b. When the Manufacturing Constraints dialog parameters are changed, the aspect 
ratio checks are auto refreshed when the dialog is dismissed.  Previously, the 
aspect ratio checks would only refresh when the Rebuild and Recalculate option 
was selected but this didn’t handle stack up designs where no impedance 
structures exist 

c. On the Manufacturing Constraints dialog the Set New button renamed to Set to 
more accurately reflect the functionality.  The Set button no longer automatically 
closes the dialog 

d. The left-most row header column is now supported to select the Active 
Constraints Data Grid row 

e. Improvements to the Edit Constraint dialog layout and added usage instructions 
 

 
Version 23.03.01 

Enhancements / changes / additions 
1. Material Library Filter / Search Enhancements - 001-00-000910 

a. Completely new and improved filtering system implemented for the Material 
Library, Add Material and Swap Material options 

b. The filter options are now placed above the selected material Data Grid, so they 
are always accessible and easily editable 

c. The current filter settings are shared between the Material Library, Add Material 
and Swap Material options.  When the Material Library, Add Material and Swap 
Material options are closed the current filters are automatically reapplied when 
these options are next used  

d. Filters are also retained between Speedstack sessions 
e. Please Note: the previous filtering system, including the ability to Load and Save 

Filter files (.mlf), has now been retired. Rather than needing to use Load and 
Save, the current filter settings are automatically saved in order that they can be 
shared between the Material Library, Add Material and Swap Material options 

2. Online Library now has three modes: 
a. Online Polar Library.  This connects to Polar's FTP server and appends selected 

library files to the existing Speedstack library. This requires an internet connection 
and security settings that permits use of FTP.  If IT policies prevents connection 
to our FTP server, select option ‘b’ or ‘c’ 

b. On-Premise Mode with Download option (new for 2023).  This option downloads 
the complete set of On-Premise material libraries so that they are stored locally.  
It is then possible to append selected library files to the existing Speedstack 
library.  This requires an internet connection but overcomes the problem where 
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FTP access is not permitted as it uses the HTTPS protocol for downloading the 
complete set of material library files. 

c. On-Premise Mode with Browse option.  A complete set of On-Premise material 
libraries are supplied as a Zip file, which can be Unzipped to a chosen folder 
location and then Browse to that location.  It is then possible to append selected 
library files to the existing Speedstack library.  This method is suitable where 
users have no internet connection so options ‘a’ and ‘b’ are not available.   
Please contact polarcare@polarinstruments.com to receive the Zip file and Unzip 
to a suitable folder location that is accessible by Speedstack 
 

 
Version 22.11.22 

Fixed 
1. Stack up graphic draw problem if Display Field 5 is set to Isolation Distance AND the 

bottom material of the stack is a solder mask - 001-00-000906 
2. Crash where the bottom-most layer is deleted and then the next bottom-most layer is 

right-clicked 
 
 
Version 22.11.01 

Enhancements / changes / additions 
1. Structure View Enhancements - 001-00-000905 

a. Improved vertical panning now available when a stack up design fills the editor 
window at View | Default View 

b. When zooming in and out, structure view will now remain visible rather than 
snapping back to the editor view when the maximum zoom level is reached 

c. Improved handling of stack ups with multiple structures on the same layer with the 
same target impedance and structure type 

d. Column header spacing is now corrected for stack ups where no solder mask is 
present 

e. If Display Field 5 is set to Layer Name / Data Filename, long string fields are 
truncated to prevent overspill into the Structure View graphic 

2. Import IPC-2581 Rev B. Improved support for stack up files that contain controlled 
impedance structures assigned to Mixed layers - 001-00-000901, 001-00-000904 

3. Technical Report. The Summed Isolation Distance problem when using certain material 
combinations is now resolved - 438-04-000259 
 

 
Version 22.09.01 

Enhancements / changes / additions 

1. Structure View.  Drag the stack up image to the left or use the new Show / Hide 
Structure View button to view a graphical representation of all structures on the stack up 
- 479-02-000111 

a. The structure ordering is by Target Impedance from low to high and then by 
Structure Type 

b. The view is interactive, clicking on the impedance structure trace(s) will switch to 
that structure on the Controlled Impedance tab.  Browsing through structures on 
the Controlled Impedance tab will highlight the appropriate structure in this view  

c. This new view may be exported using the new File | Export | Controlled 
Impedance Data option 

2. Online Library. Oak-Mitsui now added to the Supplier Filter option  
3. The View | Zoom Extents menu option short cut has now been assigned to Ctrl+8 - 001-

00-000895 
 

 
Version 22.07.20 
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Enhancements / changes / additions 

1. Grid View.  Accessible from a new toolbar option, Grid View presents the current stack 
up in an editable data grid form to allow for easy editing of multiple materials from a 
single dialog.   
The Grid View can be edited directly or the stack up can be copy & pasted to Excel, 
allowing data to be merged with other spreadsheet-based stack up information before 
being pasted back to Grid View. 

2. Stack Up Notes.  User interface improved to inform users where notes should be 
entered that are subsequently printed on the technical report - 001-00-000897     

3. The Tools | Options | Structure Defaults | Separation Region Dielectric (REr) now 
supports double data types.  Previously, it only supported integers - 438-04-000252 
 

 
Version 22.05.06 

Enhancements / changes / additions 

1. Online Library. AGC now added to the Supplier Filter option  
2. Improvements to the way the impedance structure substrate height (H parameter 

values) are calculated for Embedded Microstrip structures when the outer electrical layer 
is designated as Mixed. 001-00-000893, 479-02-000109 

3. Confidential Stamp Options added to the technical report.  The location and text can be 
configured using the new Confidential option from the technical report Options menu.  
438-04-000182 

 
Fixed 

1. If a stack up was created with just two ident materials with no other different material 
types, an exception would occur.  This is now resolved.  438-04-000246 
 

 
Version 22.01.01 

Enhancements / changes / additions 

1. New Snap Parameters and Calculate Structure feature added to the Controlled 
Impedance tab toolbar. 458-02-000012, 001-00-000500, 438-03-000103, 438-03-
000329, 438-03-000200, 326-01-000059, 409-01-000002, 458-01-000064, 325-01-
000481  

a. Snap / round parameters to practical values that are more appropriate for 
fabrication 

b. The Snap feature supports the following structure parameters : Lower Trace 
Width (W1), Upper Trace Width (W2), Lower Ground Strip Width (G1), Upper 
Ground Strip Width (G2), Trace Separation (S1), Ground Strip Separation (D1), 
Trace Offset (O1) 

c. The Snap To value for each parameter is held in the configuration settings, Tools 
| Options | Structure Defaults tab 

2. The Material Library now supports materials with a dielectric thickness tolerance of 0%.  
Previous versions of Speedstack would prompt the user to enter a value greater than 
0%. 001-00-000880 

3. The Speedstack installer will now upgrade the existing version without needing to 
uninstall first. 
 

 
Version 21.11.17 
 
Fixes 
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1. On flex core materials, when selecting the upper or lower copper regions, the blue 
highlight did not always highlight the copper region.  This is now resolved.  001-00-
000883 
 

 
Version 21.11.01 

Enhancements / changes / additions 

1. Material note enhancements.  458-01-000030, 438-04-000106, 001-00-000286, 001-00-
000262, 438-03-000673  

2. Core and Flex Core materials have now been expanded to support 15 notes fields.  5 x 
Upper Copper Notes, 5 x Dielectric Notes, 5 x Lower Copper Notes 

3. RCC and Shield materials have now been expanded to support 10 notes fields.  5 x 
Copper Notes, 5 x Dielectric Notes 

4. Material Library updated to support new material note properties   
5. Material library import & export CSV / text file format for Core, Flex Core, RCC and 

Shield materials has been expanded to support the new material note properties 
6. Stack up editor and Printing updated to support new material note properties 
7. New import / export XML STKX v23.00 and SSX v13.00 file formats to support the new 

material note properties 
8. CSV export option enhanced to support the new material note properties 
9. Online Library.  On-Premise Mode now provides an Application Note link with details on 

how to configure the on-premise mode library and obtain the latest material library data  
 
Fixes 

1. When adding an impedance structure to a core from the right-click menu, the electrical 
layer was sometimes deselected if the Controlled Impedance tab wasn't selected.  This 
has now been resolved.  458-02-000011 

 
 
 
 
 
Version 21.07.08 

Enhancements / changes / additions 

1. New drill cap feature.  Two new properties have been introduced: First Layer Capped, 
Second Layer Capped.  The Add Drill and Drill Properties dialogs have been updated 
with checkboxes to identify whether a drill is capped - 442-02-000095, 001-00-000850, 
001-00-000550, 442-02-000217 

a. For mechanical through plated drills it is now possible to cap the First Layer, the 
Second Layer or both 

b. For laser through plated drills it is now possible to cap the First Layer  
2. Graphics and Printing updated to support new drill capped properties 
3. New import / export XML STKX v22.00 and SSX v12.00 file formats to support the new 

drill capped properties 
4. CSV export option enhanced to support the new drill capped properties 

 
Fixes 

1. Structures are sometimes removed from the Master stack up when sub-stacks are 
created using the Add Stack - Define by Layers option - 001-00-000871 

 
Version 21.05.06 

Enhancements / changes / additions 

1. New Layer Name property added to the electrical / copper layer element of a material for 
Foils, Cores, Flex Cores, RCCs and Shields.  Speedstack will continue to use the 
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automatic layer numbers but this new text field allows users to key in their own layer 
names 

2. Layer Name supported in the Properties dialog, Selected Item Information grid and 
mouse over the electrical layer where the Layer Name will now display alongside the 
layer number and the amount of structures 

3. Graphics and Printing updated to support new Layer Name property 
4. Configuration Options | General | Display Field 5 now supports Layer Name as a user-

selectable option so that it can be displayed alongside the stack up graphic 
5. For first time installation the Configuration Options | General | Display Field default 

settings have been changed as follows: 
a. Display Field 3 = Description (as before) 
b. Display Field 4 = Dielectric Constant / Loss Tangent 
c. Display Field 5 = Process Thickness  

6. New import / export XML STKX v21.00 and SSX v11.00 file formats to support Layer 
Name property 

7. CSV export option enhanced to support the new Layer Name property 
8. Gerber export option enhanced to support the new Layer Name property 
9. DXF export option enhanced to support the new Layer Name property 
10. The number of Copper Finishing classes has increased from 4 to 20.  User selectable 

plating thicknesses under Finishing Options (Copper Coverage & Simple % Methods) - 
438-04-000191, 001-00-000868 

 
Version 21.04 

Enhancements / changes / additions 

1. Frequency Dependent Calculations enhancements.  The All Losses plot y-axis and data 
series labelling has been improved.  Now easier to distinguish between Smooth 
Conductor Loss and Conductor Loss with Roughness - 473-03-000011 

2. Frequency Dependent Calculations enhancements.  The result data grid column 
labelling has been improved.  Now easier to distinguish between Smooth Conductor 
Loss and Conductor Loss with Roughness - 473-03-000011 

3. Printing. The All Losses plot y-axis and data series labelling has been improved.  Now 
easier to distinguish between Smooth Conductor Loss and Conductor Loss with 
Roughness - 473-03-000011 

4. CalcEngine. Updated to the latest edition (v21.03.01) 
5. Frequency Dependent Calculations graphing enhancements.  Now supports the latest 

edition of the PolarGraph library (v20.10) to match the version delivered with the 
Si8000m and Si9000e 

 
 
Version 21.03 

Enhancements / changes / additions 

1. New Apply Plating Colours toolbar option.  Automatically assign different colours to 
plated and un-plated copper layers.  Plated layers are determined by checking the 
copper base and finished thickness, Plated = boolean(finished thickness > base 
thickness) 

2. The Tools | Options | Colours has two new customisable colours that can be specified 
for plated and un-plated copper layers 

3. Online Library.  Rename supplier from Hitachi to Showa Denko - 001-00-000854 
4. Online Library.  Tatsuta now added to the Supplier Filter option - 001-00-000860 
5. Online Library.  More frequencies added to the 'Filter by Frequency' option - 001-00-

000855 
6. Online Library.  When On-Premise mode is selected a single call to check internet 

connectivity sometimes causes a 'The remote name could not be resolved' message if 
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no internet connection available.  This has now been resolved.  001-00-000856, 470-02-
000014 

7. Printing.  For rigid-flex designs with sub-stacks, long sub-stack names on the overview 
page could sometimes be truncated.  This is now detected and word wrapped over 
multiple lines - 438-04-000183 

8. Printing.  When generating a report the page numbering / total pages numbering has 
now been corrected - 001-00-000861 

9. More robust error handler code for instances where Speedstack.exe.config is missing / 
corrupt  

 
 
Version 21.02 

Enhancements / changes / additions 

1. New Shield material added - 438-02-000122, 438-03-000478, 458-02-000007, 001-00-
000369, 438-03-000294, 438-03-000427, 438-03-000428, 429-03-000020 

2. Graphics and Printing updated to support new Shield material 
3. New import / export XML STKX v20.00 and SSX v10.00 file formats to support new 

Shield material 
4. CSV export option enhanced to support new Shield material 
5. Gerber export option enhanced to support new Shield material 
6. DXF export option enhanced to support new Shield material 
7. Structures: When adding to the stack up an additional check has been added to detect 

when the Finished Thickness of the Reference Plane is less than 1um 
8. File | Export menu now contains a Support Information option to display an application 

note detailing the latest Polar export information 
9. CalcEngine. Updated to the latest edition v20.08.24 
10. FlexNet Publisher / FLEXlm v11.17.2 now supported 

 
Fixes 

1. Export: The Gerber and DXF export options now correctly supports the copper surface 
information for RCC materials 

2. Printing:  Problem where some drills were not printed when the stack up spanned 
multiple pages has now been resolved 
 

 
Version 21.01 

Enhancements / changes / additions 

1. FlexNet Publisher / FLEXlm v11.17.2.0 supported  
 

 
Version 20.11 

Enhancements / changes / additions 

1. Online Library.  Improved workflow aiding more rapid download of library files - 458-01-
000111 

2. Online Library.  ShengYi now added to the Supplier Filter option 
3. Material Library.  Import Library support improved for European nations that use a 

comma as the decimal symbol - 479-02-000047, 438-03-000727 
 
 
Version 20.09 

Enhancements / changes / additions 

1. Online Library.  Nan Ya Plastics now added to the Supplier Filter option 
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2. Online Library.  Updated to support Pure-FTPd secure FTP daemon v1.0.49 - 001-00-
000847 

3. Printing.  When generating the technical report it is now possible to select all pages, a 
page range or an individual page - 438-04-000134 

 
Fixes 

1. For Core and Flexible Core materials, when using Properties | Remove Copper option to 
create a single-sided core, drills are sometimes incorrectly removed when adding a sub-
stack.  This has now been resolved - 001-00-000840, 438-04-000132 

 
 
Version 20.06 

Enhancements / changes / additions 

1. Drilling Enhancements.  New Back Drill Minimum Distance From Must-Not-Cut Layer 
and Back Drill Maximum Distance From Must-Not-Cut Layer added - 001-00-000844, 
442-03-000009 

2. New import / export XML STKX v19.00 and SSX v9.00 file formats to support new drill 
features 

3. CSV export option enhanced to support new drill features 
4. Printing: Improvements to Bill-of-Materials table to better support sub-stacks - 001-00-

000843 
 
Fixes 

1. Printing: When printing in wide-stack mode the mixed layer appearance on the overview 
page has now been corrected - 001-00-000842 
 

 
Version 20.05 

Enhancements / changes / additions 

1. Drill Enhancements. The number of stack up columns available for drilling information 
has been increased from 6 to 11 

2. Graphics and Printing updated to support new Drilling features 
3. New import / export XML STKX v18.00 and SSX v8.00 file formats to support new drill 

features 
4. Online Library.  New Filter by Frequency option to select libraries where the dielectric 

constant / loss tangent data is specified at a known frequency 
5. Online Library.  New material families added for Arlon, Isola, ITEQ and TUC  

 
Fixes 

1. Printing: Solder Mask Thickness dimension arrows - 438-04-000091 
2. Printing: a problem that sometimes occurred with the drill graphic on the overview page 

has now been resolved - 001-00-000838 
3. Solder Mask Properties dielectric constant and loss tangent decimal precision (mask) 

now fixed to 4 decimal places regardless on units selected - 001-00-000841 
4. Export to CSV where data contained in language resource files sometimes caused an 

error - 479-02-000025, 001-00-000836 
 

 
Version 20.02 

Enhancements / changes / additions 

1. Enhancements to the Navigator graphics 
2. Enhancements to the Technical Report  

 
 
Version 20.01 
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Enhancements / changes / additions 

1. Drilling Enhancements: 
a. Minimum Pad Size, Minimum Drill Size, Minimum Drill Size Tolerance and 

Minimum Barrel Wall Thickness fields added to the Hole Information section - 
438-03-000479 

b. Five Note fields added - 458-01-000029, 438-03-000388, 473-02-000018 
c. New Back Drill type now supported. Back Drill Must Cut Layer No, Back Drill Must 

Not Cut Layer No, Back Drill Minimum Distance From Cut Layer, Back Drill 
Maximum Distance From Cut Layer, Back Drill Primary Drill Size fields added - 
458-01-000021, 473-02-000017, 429-03-000048  

2. Graphics and Printing updated to support new Drilling features 
3. New import / export XML STKX v17.00 and SSX v7.00 file formats to support new drill 

features 
4. CSV export option enhanced to support new drill features 
5. Gerber export option enhanced to support new drill features.  The new Minimum Pad 

Size, Minimum Drill Size, Minimum Drill Size Tolerance and Minimum Barrel Wall 
Thickness fields have been added to the export file but the Back Drilling graphic is not 
supported in the Gerber output 

6. DXF export option enhanced to support new drill features.  The new Minimum Pad Size, 
Minimum Drill Size, Minimum Drill Size Tolerance and Minimum Barrel Wall Thickness 
fields have been added to the export file but the Back Drilling graphic is not supported in 
the DXF output 

7. The File | Export | Mentor Graphics sub-menu now contains just the V11.00 and V12.00 
of STKX that are the versions supported by Mentor - 001-00-000795 

8. Four selectable plating thicknesses added under Finishing Options (Copper Coverage & 
Simple Percentage Methods) - 429-03-000038 

a. Removed the need for XML Schema for the saving of these options.  
b. Options are saved under a new filename (FinishingMethodSettings.optx) 

9. Material Library and Virtual Material Stack Up Wizards.  Increased the layer count limit 
from 64 to 128 - see ticket 458-02-000006 

10. Frequency Dependent Calculations graphing enhancements.  Now supports the latest 
edition of the PolarGraph library (v19.08) to match the version delivered with the 
Si8000m and Si9000e 

11. CalcEngine. Updated to the latest edition (v19.11.22) 
12. Cleaned up some visual glitches in Flex Navigator 
13. Coverlay.  In Virtual Material Mode the coverlay base thickness parameter value is now 

read-only to match other material types - 001-00-000807 
14. When saving stack up designs with controlled impedance structures, a warning is now 

displayed if either File | Save Stack As or File | Save Stack are selected.  The user can 
still save the stack up only file format (.STK) but are now warned that structure data will 
be lost - 438-03-000330, 440-03-000021  

15. Swap Material. Retain Data FileName for solder mask and ident materials when 
swapping with other items in library - 001-00-000772 

16. Online Library.  TUC now added to the Supplier Filter option  
17. Shortcut for Tools-Set Finishing Method now changed to SHIFT + CTRL + M (001-00-

000801)   
 
Fixes 

1. Printing: where a table header block may be left isolated at the bottom of a page where 
there is just enough space for the header but not enough for the first data row, resulting 
in the next page starting another header block. 

2. Printing: where if the Footer is disabled sub-stacks cover page will not print properly. 
 

 
Version 19.05 
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Enhancements / changes / additions 

1. DRC Resin Check / Excess Resin. Algorithm enhanced to offer better support for 
sequential build stack ups - 438-03-000615, 438-03-000397, 477-01-000007, 473-01-
000021  

2. Convert to Core.  When converting two Foils to a single Core material the lower copper 
Trace Inverted flag is now automatically set to true. This speeds up the Convert to Core 
operation, in previous versions of Speedstack it was necessary to set the Trace Inverted 
flag on the foil prior to using the Convert to Core function - 458-01-000122 

3. Convert to Core.  It is now possible to convert two Foils to either a Core or a Flexible 
Core material - 001-00-000586 

4. Online Library.  The Ventec logo has now been updated 
5. CalcEngine. Causal surface roughness calculation improvements 
6. Help | Latest Versions option added to display web pages detailing the latest Polar 

product versions 
7. Printing: Added ability to sort Impedance table that groups Single-Ended structures 

together followed by Differential structures together, per-layer - 429-03-000040   
Option found under menu [Options->Controlled Impedance Data table->Sort Structures 
in SE/Diff Order Per Layer] 

8. Printing: New Footer Section under options allowing ability to:  
a. Hide / Suppress the Footer - 429-03-000056  
b. Show an alternative/expanded footer that will accommodate long stack names - 

438-03-000682 
c. Override Main Footer labels to user-definable ones - 438-03-000682 

 Options found under menu [Options->Footer...] 
9. Printing: Stack thickness value (on the left-side of the stack) has its own decimal 

accuracy setting - 442-02-000210 
Option found under menu [Stack Data Table->Stackup Thickness Decimal Accuracy] 

10. Structure Layer Properties dialog.  Altered layout to suit Asia Pacific Windows 
(Japanese, Simplified Chinese and Traditional Chinese) - 001-00-000793   

 
Fixes 

1. Bug in Wizard where doing a Core build results in the stack up thickness with solder 
mask value being incorrect  

 
 
Version 19.01 

Enhancements / changes / additions 

1. Material Library enhancements. New loss tangent field added to eight materials, Core, 
RCC, Prepreg, Solder Mask, Flexible Core, Bondply, Adhesive and Coverlay – 458-01-
000054, 458-01-000074, 458-01-000075, 438-03-000328, 429-03-000022, 440-03-
000036 

2. Stack Up Editor enhancements. Loss tangent field now supported within the stack up 
editor for the appropriate materials: 

a. Add, swap, copy / paste materials, symmetry mode functions updated to support 
loss tangent 

b. Updated properties dialogs to support loss tangent 
c. New selectable display columns for 'Loss Tangent' and combined 'Dielectric 

Constant / Loss Tangent' next to stack up graphical image 
3. Frequency Dependent Calculations enhancements. The Dielectric Constant Ref Er 

field(s) and Loss Tangent Ref TanD field(s) may now be populated from the stack up 
materials. The new ‘Set Dielectric Constant (Er) from Stack Up materials’ and 'Set Loss 
Tangent (TanD) from Stack Up materials' checkboxes allow the user to nominate which 
data from the stack up auto-populates the Ref Er and Ref TanD columns, deselecting 
allows the user to key in the value(s) 
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4. Printing. New selectable 'Loss Tangent' column for the stack up data table  
5. Virtual Material Mode wizard updated to support loss tangent. 
6. Updated bi-directional copy / paste interface between Speedstack and Si9000e now 

with improved support for loss tangent (Ref TanD) 
7. New import / export XML STKX v16.00 and SSX v6.00 file formats to support loss 

tangent and new drill fill types 
8. IPC-2581 Rev B import / export options enhanced to support loss tangent 
9. CSV export option enhanced to support loss tangent 
10. Gerber export option enhanced to support loss tangent 
11. DXF export option enhanced to support loss tangent 
12. Rigid-Flex Improvements. When introducing air gaps into a sub-stack that previously 

had contiguous materials it is now possible to reassign this sub-stack to one that 
contains mini-stacks, by using the 'Reset Mini-Stack Settings' option from the Navigator 
menu. This is especially useful when designing 'book-binder' or 'doublet' rigid-flex 
constructions. 

13. Online Library. When using On-Premise Mode no calls are now made to 
ftp://polarinstruments.com to check whether it is reachable. Previously, this check in 
itself can cause an error if no internet connection is available – 470-02-000014 

14. Online Library.  Pillar now added to the Supplier Filter option - 468-01-000028 
15. Drill / Via Fill Types. Non-Conductive, Conductive, Sintering Paste and Copper Paste fill 

types have now been added - 473-02-000015 
16. Configuration Options. When Speedstack is installed for the first time the licensing will 

default to the Si9000e link rather than the Si8000m link - 001-00-000773 
17. Configuration Options. The option to set the amalgamated dielectric constant threshold 

has been deprecated. New amalgamation algorithm implemented 
18. Ucamco Interface. The File menu 'Save and Continue' and 'Save and Quit' options now 

support the SSX v6.00 file format – 001-00-000777 
19. Ucamco Interface. The File menu 'Discard and Quit' message has been altered to clarify 

functionality - 001-00-000778 
20. Material Library. The Description column default width in the material library has now 

increased to 300 pixels for all material types - 438-03-000639 
21. Impedance and Insertion Loss Calculations – new calculation engine supported. These 

improvements may slightly alter the calculation results 
a. New amalgamation algorithm – now amalgamates multiple substrates to a single 

substrate for both dielectric constant and loss tangent 
b. Modifications implemented to support causal surface roughness 
c. Differential Offset CoplanarStrips 2B2A – substrate three (H3) and four (H4) 

calculation corrected - 001-00-000756 
22. Printing. Legacy print options have been deprecated – 438-03-000620   

 
Fixes 

1. Behaviour difference between Add CI Structure menu item and impedance toolbar '+' 
button. The dialog to nominate how mini-stacks should be handled does not appear 
when the Add CI Structure menu item is selected – 001-00-000771 

2. Printing. On some occasions the ‘Stack Up Thickness (laminate to laminate)’ option did 
not correctly include the foil thickness on sequential lamination builds.  This is now 
resolved - 479-01-000017 

 
 
Version 18.08 

Enhancements / changes / additions 

1. Updated Export to IPC-2581 Rev B option with interactive interface.  Now supports stack 
up material and structure information (458-01-000016, 458-01-000087, 001-00-000649, 
001-00-000746, 438-03-000519, 438-03-000521, 438-03-000519) 
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2. New Import IPC-2581 Rev B option with interactive interface. Supports stack up material 
and structure information (438-03-000262, 429-03-000031, 468-01-000020, 458-01-
000051) 

3. Online Library. New On-Premise Mode to allow for users who cannot connect to 
ftp://polarinstruments.com due to network security restrictions (473-01-000009, 473-01-
000008, 464-01-000029, 438-03-000585, 001-00-000734) 

4. New Coplanar Structure support. Eight new structures have been added, requested 
specifically for flex and rigid-flex designs (429-03-000028, 458-01-000039, 001-00-
000706, 438-03-000514, 427-01-000044, 429-03-000046) 

a. Four new single-ended structures: Offset Coplanar Strips 1B2A, Offset Coplanar 
Strips 2B2A, Offset Coplanar Waveguide 1B2A, Offset Coplanar Waveguide 
2B2A 

b. Four new differential structures: Differential Offset Coplanar Strips 1B2A, 
Differential Offset Coplanar Strips 2B2A, Differential Offset Coplanar Waveguide 
1B2A, Differential Offset Coplanar Waveguide 2B2A 

5. Tools | Options | Licensing tab has new layout to more clearly define the Speedstack 
PCB and Speedstack Si bundles (442-02-000227) 

6. New import / export XML STKX v15.00 and SSX v5.00 file formats to support eight new 
coplanar structures 

7. Updated import / export XML STKX v14.00 file functionality now supports <Structure> 
<T1> trace thickness value. Previously, this was determined from the electrical layer 
<FinishedThickness> value but now also added to <Structure> for completeness 

8. Update the import / export XML STKX v14.00 and SSX v4.00 so that files are 
transferable between Windows locales where the decimal symbol changes from decimal 
point to a comma (001-00-000754) 

 
Fixes 

1. Fixed a problem where the context menu keeps showing drills menu after a copy & 
paste stack operation (001-00-000738) 

2. Fixed a bug where symmetrical drills not being deleted when Symmetrical Mode is On 
(001-00-000741) 

 
 
Version 18.05 

Enhancements / changes / additions 

1. Frequency Dependent Calculations  
a. New Cannonball-Huray method added to Surface Roughness Compensation 

options. This requires the entry of Matte and Drum side Rz values 
b. Updated bi-directional copy / paste interface between Speedstack and Si9000e 

allows for quick transfer of structure parameters between products – Cannonball-
Huray parameters now supported 

c. New import / export XML STKX v14.00 and SSX v4.00 file formats to support 
Cannonball-Huray parameters 

2. Material Online Library Enhancements 
a. New ITEQ core and prepreg materials 
b. ITEQ now added to the Supplier Filter option (468-01-000028) 

3. Printing. New selectable 'Copper Layer Type' column to determine layer type; Signal, 
Plane etc. (458-01-000091) 

4. Printing. New selectable impedance table ‘Error %’ field.  Print the Error % between the 
Target and Calculated Impedance (469-02-000043) 

5. Printing. Loss Graph page, the Cannonball-Huray Matte and Drum side Rz values 
added if the Enable Cannonball-Huray checkbox is selected 

 
Fixes 
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1. Printing: Fixed a problem where Thickness arrowed lines may fall off further than the 
bottom of the stack 

2. Printing: Fixed a problem where if Loss Graphs are on, but no FD data exists or have 
been set to not be included - then blank trailing pages were being printed (442-02-
000226) 

3. Printing: Fixed incorrect filename in print header, was showing <filename>.stk even 
when an <filename>.sci file was opened  

4. HDI Build | Drill Plan: Fixed a problem where the Drill Hole Count property was not 
always transferred correctly from the master stack to the auto-created sub-stacks (458-
01-000092) 

 
 
Version 18.03 

Enhancements / changes / additions 

1. Frequency Dependent Calculations  
a. Amalgamated dielectric structures now support frequency dependent calculations 
b. New ‘Set Er values from Stack Up materials’ checkbox. Selecting this checkbox 

auto-populates the Ref Er column, deselecting allows the user to key in the 
value(s) 

c. New ‘Include Loss Graph for this structure on the report’ checkbox allows the user 
to nominate which structures will contain a separate loss graph page  

d. The ‘Frequency of Interest’ results section of the report now match the Result 
Presentation setting, allowing the Loss results to be shown in  dB/m, dB/inch or  
dB/LL (length of line). Previously, only the native CalcEngine results in dB/m were 
used. 

2. Printing. New user-selectable options to show a dimension arrow for ‘Stack Up 
Thickness (solder mask to solder mask)’ and ‘Stack Up Thickness (laminate to 
laminate)’ (438-03-000461) 

3. Printing. Stackup Cost and Hatch Profile Data now separated from Thickness Totals, 
and can be turned on and off from menu. (458-01-000099) 

4. License feature change. The new 2018-style license features support additional data 
such as Polarcare Contract information. Please note, 2018 features will not support pre-
v18.x versions of our products 

 
Fixes 

1. Fixed: Printing: When an RCC is used and the Processed Thickness column is selected 
the dielectric finished thickness is missing (001-00-000720) 

2. Fixed: The File | Properties dialog revision information display problem that occurred 
with Win 7 when using font scaling at 125% is now resolved (458-01-000098) 

 
Version 18.01 

Enhancements / changes / additions 

1. Frequency Dependent Calculations: 
a. New frequency dependent calculation capability added to Speedstack where 

insertion loss can be graphed over a user-specifiable frequency range 
b. Additional frequency dependent structure properties added to allow for insertion 

loss calculation: trace conductivity, frequency range, result presentation mode 
c. Extended substrate data supported: frequency vs dielectric constant / loss 

tangent 
d. Surface roughness compensations modes supported: Smooth, Hammerstad, 

Groisse, Huray 
e. Extensive graphing capability introduced: multiple data series options, pickable 

data points 
f. Technical report extended to include insertion loss graphs 
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g. Bi-directional copy / paste interface between Speedstack and Si9000e allows for 
quick transfer of structure parameters between products 

h. New import / export XML STKX v13.00 and SSX v3.00 file formats to support 
frequency dependent structure properties 

Fixes 
1. Excess resin property / field does not unit switch correctly in the material library for 

adhesive and bondply materials. Now corrected. (001-00-000712) 
 
 
Version 17.08 

Fixes 
1. The warning message displayed when the SCI / STK file version is newer than that 

supported by Speedstack is now corrected (001-00-000704) 
2. When reading the <ExcessResin> element from XML files STKX v11.00, v12.00 and 

SSX v1.00, v2.00 the data was not imported correctly unless the units were set to 
microns. Now corrected. (473-01-000024) 

 
 
Version 17.07 

Enhancements / changes / additions 
1. Online Material Library Enhancements 

a. New Circuit Foil and Mitsui foil materials 
b. New ITEQ core materials 
c. Circuit Foil and Mitsui now added to the Supplier Filter option 

 
2. Impedance Calculations 

a. New calculation engine supported.  This matches the calculation engine v17.03 
supplied with Si8000m / Si9000e v17.07 

 
3. Proportional View Enhancements 

a. Improved support for mixed signal / ground electrical layers 
 
 
 
Version 17.05 

Enhancements / changes / additions 
1. Material Library Enhancements 

a. New Online Library facility to download the latest material libraries.  Quickly and 
easily download the preferred materials from the Polar Online Library 

b. New Open and Append Library option.  Append library data to the existing 
material library file which allows the user to quickly ‘mix and match’ data from 
different material suppliers 

c. New Clear Current Data Table option.  Clear an individual material type (Foils, 
Prepregs, Cores etc) whilst leaving the remainder of the material library 
unchanged 

2. Proportional View Enhancements 
a. Corrections to the display of isolation distance thicknesses (001-00-000687) plus 

the start-up zoom level of the stack up has been improved 
3. UCAMCO Script/Batch Option Improvements (001-00-000698) 

Fixes 
1. Material Library, when the RCC material tab is empty the Filter option for Prepreg 

materials was incorrectly disabled - now resolved (001-00-000674) 
2. Material Library, when using the import / export option to CSV or TXT file the Excess 

Resin values are not handled correctly unless the units are set to microns - now 
resolved (438-03-000396) 
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Version 17.04 

Enhancements / changes / additions 
1. Material Library Enhancements 

a. Import and Export to CSV / TXT file now allows for individual material data tables 
to exported and imported without needing to clear the whole library.  This 
provides a better workflow when using third-party software to edit the library such 
as Excel.  Changes can easily be made to any material data table by exporting / 
importing, the imported data can replace or be appended to the existing data 
whilst leaving the other materials are left untouched 

b. When opening a new material library the data is no longer appended to the 
existing data, it now replaces the current loaded library 

2. Printing:  New Isolation Distance (Summed) column added to the selectable stack data 
columns (429-03-000037) 

Fixes 
1. Removed 'isolation distance' values wrongly showing for Ident / solder mask peelable 

materials 
2. Printing bug where Isolation Distance values were not showing for adhesives and 

coverlays 
3. Multiscreen environment - Navigator remove substack dialog always opens on screen 1 

which can cause problems if screen 1 is not being used - hidden / missing dialog. 
Changed dialog StartPosition to CenterParent so now positions in centre of Navigator 
(001-00-000696) 

4. If symmetry mode is enabled and a stack up wizard is called the symmetry toolbar will 
unpress but the toolbar image does not update - now resolved (001-00-000697) 

5. Printing bug where thickness line doesn't account of prepregs above coppers in 
substacks (438-03-000508) 

 
 
Version 17.02 

Enhancements / changes / additions 
1. STKX XML format.  The STKX v11.00 export option has been modified so that the 

<Core> <LowerCopper> XML element names are renamed to LowerCuBaseThickness 
& LowerCuFinishedThickness to maintain compatibility with third-party systems  
 

 
Version 17.01 

Enhancements / changes / additions 

1. Flex Navigator Display Positioning – ability added via material attributes 
a. PolarDerivedMaterials.CMaterialAttribsProcessor (New Class) 
b. Reset switch added to restore NVDP values back to zero 

2. UCAMCO script/batch trigger options added to File Menu 
a. Save & Continue 
b. Save & Quit 
c. Discard & Quit 

3. Resolution check on startup now removed 
4. Printing: Added C2, C3 and Trace Pitch Fields to CI table  
5. Splash Screen can now be bypassed by holding down SHIFT KEY during startup 
6. frmStackup.ApplyFinalFinishing completely rewritten. This now overcomes the situation 

where the HValues used by structures were sometimes incorrect for sub-stacks where 
the materials ONLY existed in the sub-stack (not enabled in the Master), most 
commonly used in bikini builds. The copper finished thickness was sometimes not 
correctly applied to the dielectric HValue property for those materials that were not 
enabled in the Master, the new function overcomes this issue 

7. New SCI / STK v12 file format. New CSTMaterial.Attributes property, new 
CSS_Structure.NetClass property to contain up to 5 x Net Classes, 
CSTFlexStackData.InfoFileRev4_RevisionDate  now correctly stored  
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8. New Net Class functionality. Five new Net Class properties can be stored per structure, 
accessible from the controlled impedance toolbar  

9. SSX XML format enhancements 
a. now uses CultureInfo.InvariantCulture to enforce decimal point usage.  This 

should overcome the issue where SSX files exported in regions where the locale 
uses comma as a decimal symbol (Germany etc.) would not be read in regions 
where the decimal symbol is a point.  

b. now includes improved support for multiple coating parameters (C1, C2, C3, CEr).  
Previously, only the C1 parameter was imported, C2 and C3 were set to the same 
value 

c. v2.00 updated to include the new material attributes and structure net classes 
d. export option provides capability to export to multiple versions, 1.00 or 2.00, in 

order to maintain compatibility with third-party systems 
10. STKX XML format enhancements 

a. now uses CultureInfo.InvariantCulture to enforce decimal point usage.  This 
should overcome the issue where STKX files exported in regions where the locale 
uses comma as a decimal symbol (Germany etc) would not be read in regions 
where the decimal symbol is a point. 001-00-000572 

b. v12.00 includes the following changes 
i. <FileRevision> – removed, replaced with 4 x Revision(n)Number, 

Revision(n)Editor, Revision(n)Number, Revision(n)Date properties 
ii. <StackChanged> – removed 
iii. <Filename> – removed  
iv. <Version> – only a single Version is now specified in the Header section for 

the whole file, previous versions of the STKX format had separate 
<Version> definitions at the start of each section 

v. <Attributes> – new property added to all materials 
vi. <SolderMask> <SolderMaskMask> <Colour> – colour text field has been 

renamed to <MaskColour> in order to differentiate it from the new RGB 
colour data 

vii. <Ident> <IdentInk> <Colour> – colour text field has been renamed to 
<InkColour> in order to differentiate it from the new RGB colour data 

viii. <Peelable> <PeelableMask> <Colour> – colour text field has been 
renamed to <InkColour> in order to differentiate it from the new RGB colour 
data 

ix. <Colour> – RGB colour properties added to all materials, separate colour 
definitions for each material element – for instance a <Core> supports a 
separate colour definition for the <UpperCopper>, <CoreDielectric> and 
<LowerCopper> 

x. <StructureNumber>, <H1>, <Er1>, <H2>, <Er2>, <H3>, <Er3>, <H4>, 
<Er4>, <C1>, <C2>, <C3>, <CEr>, <NetClass1>, <NetClass2>, 
<NetClass3>, <NetClass4>, <NetClass5>  – new properties added to 
Structure 

c. export option provides capability to export to multiple versions, 11.00 or 12.00, in 
order to maintain compatibility with third-party systems 

11. Display / Printing: Mask Thickness now added to the Processed Thickness column. This 
now allows the user to select a single Process Thickness column to contain all critical 
info for both display and printing 

12. DRC. The Design Logic check now detects single-sided cores, adhesives and bondply 
materials beyond the outer copper layers – the new DRC error message for these 
occurrences is 'External Dielectric' 

13. DRC. If the Design Logic check detects errors with a stack up it is not possible to add 
structures. It is now possible to disable the Design Logic check and continue to add 
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structures to the 'valid' part of the stack up. Messages have been introduced into 
Speedstack to guide the user when these situations occur 

14. Hatch. Guidance return path notes added when copper coverage is less than 40 
percentage 

15. Proportional view. Beta feature that displays the stack up where the material 
thicknesses are proportional to each other. This can be informative as a visual aid, 
especially when considering the dielectric thicknesses between electrical layers 

Fixes 

1. Fixed: Printing: bug where print queue order is missing items, showing only the stack 
table being available. 

2. Fixed: Keyboard shortcut for opening Config Options clashed with Open stk shortcut, 
changed Config Options shortcut to Ctr+, (comma) 

3. Fixed: Soldermask will no longer display Base and Finished Thickness 
4. Fixed: Mask Thickness added to Data Field 5 (graphics display) 

Version 16.03 

Features 

1. Printing: Bill of Materials table (BOM) With barcoded stock-number support added to Print 
Report. (001-00-000625) 

2. Printing: Default folder path for custom print settings files can now be set under main 
configuration settings. (438-03-000356) 

3. Printing: Quickly scroll through pages using mouse wheel. 
4. SI_Image Control (structure image control) updated. 
5. Splash Screen and About dialogs updated. 
6. Splash delay-time increased. 

Fixes 

1. Default file locations in * .inix config file causes crash when paths are empty 
2. Printing: Drills Data Alignment menu checkbox was always fixed to 'left' regardless of 

settings 
 

Version 16.01 

Features 

1. It is now possible to retain and re-allocate structures when changes are made to the electrical 
layers of the stack up. Structure Layer Properties and Structure Validation toolbar 
options have been introduced to the Controlled Impedance tab to allow the user to re-
allocate structures after the following stack up changes: 

a. Add foil / core – increase layer count 
b. Delete foil / core – reduce layer count 
c. Move foil / core up and down, beyond another copper layer – maintain layer count 

but perhaps to swap two different thickness cores within the stack up 
d. Copy / paste foil or core – increase layer count 
e. Change layer type – signal to plane, plane to signal, mixed to signal or plane, signal 

to hatch, hatch to signal. 
f. Delete rigid core and add flex core – to maintain layer count but swap material type 
g. Delete a rigid core and add two foils – to maintain layer count but switch to an HDI 

type build 

Fixes 
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1. Fixed Windows XP problem when trying to save a newly created stack file. Issue related to 
older config paths containing trailing backslash (which is no longer needed in latest v1 5.10 
onwards) (438-03-000348) 

Version 15.10 

Features 
1. Application configuration files now moved to the Windows-compliant folders. 

a. Windows Vista, 7, 8, 10: \Users\<UserName>\AppData\Roaming\Polar 
b. Windows XP: \Documents and Settings\<UserName>\Application Data\Polar 

2. Support for Windows 10 
3. FlexNet Publisher / FLEXlm v11 .13 now supported 

Fixes 

1. Fixed problem when using the Copy to Si Project option where the REr parameter value 
was not transferred to the clipboard correctly. (438-03-000331) 

Version 15.07 

Features 

1. Copy / Paste Structure data between Si8000m / Si9000m and Speedstack. The existing 
copy / paste structure clipboard format used with Speedstack has been updated to 
accommodate new data 

2. Copy from Speedstack to Si8000m / Si9000e Project. A new toolbar option has been 
introduced to Copy a group of structures from Speedstack and place them onto the 
clipboard. These structures may then be pasted directly into the Si8000m / Si9000e 
Project group 

3. User Interface Language. The user interface language is now selected from a new Tools | 
Language option, the options available are dependent upon the Speedstack language 
packs installed. 

4. Additional menu keyboard shortcuts assigned 
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Fixes 

1. Fixed problem in printing where notes for the last sub-stack were printed in notes section 
for every sub-stack (438-03-000316) 

2. Fixed problem with Tools | Options | Rebuild and Calculate Structures - selections did store 
correctly (001-00-000571) 

3. Fixed problem with Export to CSV option where extremely large contiguous text string 
sometimes caused an exception error (001-00-000579) 

4. Old password tab completely removed from configuration dialog 

Version 15.05 

Features 
1. Speedstack now built on later development platform 
2. Export to Ucamco Integr8tor and Ucam option. New option added to Export menu for Ucamco 

integration project. XML .SSX format 
3. Import Ucamco Integr8tor and Ucam option. New option added to Import menu for Ucamco 

integration project. XML .SSX format 
4. Support Speedstack command line launch with XML .SSX files 
5. Export / Import Ucamco Integr8tor and Ucam option secured by new SPEEDSTACK_UCAMCO 

license feature, Tools | Options | Licensing allows this option to be selected 
6. Support Speedstack command line launch with Ucamco .JOB files 
7. Export to Cadence Allegro option 
8. Export to Mentor Graphics option 
9. Export to Zuken CR-8000 option 
10. Import from Zuken CR-8000 option 
11. Most Recently Used (MRU) list added to the File menu 
12. Improved Material Library locking feature using a password. 
13. Printing: Stackup Thickness / Board Thickness now has separate number accuracy setting 

(001-00-000556) 
14. Warning is now given when user attempts to delete all structures (001 -00-000480) 
15. Command line launch capability controlled by the claimed license feature. .stkx, .job and .ssx 

can only be opened via the command line if the appropriate license feature is available. 
16. It is now possible to select Speedstack Flex / HDI Navigator and use the option without 

requiring either a Si8000m or Si9000e licenseStack Up Cost added to the Stackup Information 
data grid and the technical report totals area. Stack Up Cost is the sum of all the enabled 
materials within a stack up 

17. Autostack feature removed 

Fixes 

1. No warning to save file changes was given after structures are re-calculated/re-built despite 
knowing that the file has definitely changed since opening/saving. (442-02-000098) 

2. Printing: when turning off the file-path in header it also removes the unit data. (438- 03-
000247) 

3. When adding sub-stack using a layer range and a single-sided core is one of the layer 
extents. Fixed (001-00-000551) / (001-00-000502) 

4. Saving stk throws error after importing an stkx file from location that doesn't match file 
location in the stkx file. (001-00-000525) 

5. Printing: Data filename was not appearing for solder masks in printout. 
6. Material Library. Filter bug where an invalid criteria string will cause crash. (438-03- 000306) 
7. Minor annoyance where if the last opened file saved in config file cannot be found, that file 

path is removed from the config. 
8. Printing. Thickness totals spills off the page if Hatch profile is used. 

9. Setting of material colours not working when language is set to German. (438-03- 000312) 
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Version 14.09 

Features 

1. Export to IPC-2581 Rev B. Enhancements including the use of a period (".") as a decimal 
symbol in floating point numbers regardless of locale (438-03-000124) 

Version 14.05 

Features 

1. New Export to IPC-2581 Rev B interface (001-000-000206, 001-00-000258) 
2. Updated Import Ucamco .Job File interface to support latest file formats (438-03-000031, 

438-03-000048) 
3. Minor change to structure browser index control – lowercase ‘of’ now used to improve clarity 

of display 
4. Printing now retains the last-used printer as well as the last-used paper-size, rather than 

using the default printer / paper-size as defined under windows. Defaults will be used 
where a printer or paper-size is unrecognised or is unavailable 

5. Printing now supports users who regularly want to switch between different language locales in 
order to send documentation to their internal and external suppliers (001-00- 000461) 

6. Printing Stack Thickness values (beside the stack) now obeys the user selectable number 
format settings (442-02-000084) 

Fixes 
1. Stack properties now displayed ready for user input after Material Library Mode Wizard is 

used (438-03-000037) 

Version 14.02 

Features 

1. New Copy / Paste Material Properties 
a. Provides functionality to copy all properties from selected material and then 

paste user-selectable property groups to other materials 
b. Supports multi-selected materials for rapid stack up changes 

2. New Material Library Wizard 
a. Extra Prepreg Fields 
b. Plane & Mixed Layer support 
c. Displays running Thickness Total 

3. New Laser Stacked via type 
a. Adds multiple laser stacked vias in a single operation 

4. Updated Set 'Stackup Thickness / Enable Finishing ’ dialog 
a. Tolerance values can now be entered as either a percentage or an absolute value 

dialog will default to % upon loading 
5. Menu text changes 

a. Tools | Set Finishing Options now renamed Tools | Set Finishing Methods 
b. Tools | Set Target Thickness / Finishing Options now renamed Tools | Set 

Target Thickness / Enable Finishing 
c. Materials are now grouped more logically into rigid / flex / other sections within 

menu system 
d. Right-click stack up editor menu items now match order of toolbar 
e. Copy / Paste Material Properties now added to the right-click menu 

6. Set Finishing Methods now has URL to the AP507 application note 
7. Configuration defaults 

a. The default for Maximum Laser Drilled Via is now 5. Previously 1 
b. The default for Amalgamated Dielectric Differential Threshold is now 1.0. Previously 

0.5 
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8. Toolbar icons and menu entries are now always enabled regardless of tab selected (Stackup 
Editor | DRC | Controlled Impedance) 

a. Previous versions disabled certain options to indicate when that they should not be 
used during the stack building process but this resulted in a lot of switching between 
tabs 

9. When adding drills, the drill-type, fill-type and plating are remembered for when another drill 
is added (speeds up repetition) 

10. Symmetry Mode button is now more obvious when it is On / Off 
11. Ability to delete all drills from the stack in a single operation - new context menu 
12. Printing: Drills (Drills Table) order sorted by start-end layer order or creation order (user 

option) 
13. New Library Mode / Virtual Material Mode toggle toolbar option 
14. Saving file on shutdown now saves a .sci file with impedance structures rather than a .stk file 

without impedance structures 
15. Target Stack Up Thickness now added to the Stack Up Information grid 

Fixes 
1. Fixed bug where the stack properties dialog still appears even after cancelling the virtual-

material-mode wizard 
2. String "Layer can only be Mixed or Plane" used in VMM wizard was not localized, now 

reads: "Conflicting Layer Types - Layers cannot be both planes and mixed at the same 
time." 

3. RCC Property bug: Remove Copper checkbox now properly disabled Fixed 
5. Printing bug: Fixed Thickness Tolerance accuracy according to units 
6. Printing bug: Fixed incorrect toolbar icons 
7. Main UI bug: Keyboard shortcut for Undo now working 
8. Finished Thickness bug fixed when the .Net Framework v1 .1 is used 
9. Main UI bug: Zoom extents bug when Navigator is not docked - fixed. 
10. VM Wizard bug: Drill Section - Deleting a drill when there are none crash - fixed 
11. Main UI: Zoom extents bug fixed when RCC is the top layer 

Version 13.06 

Features 
1. New Rebuild and Calculate Structure configuration options have been introduced. These 

options allow the user to determine whether the impedance structure parameters are 
populated automatically from the stack up or manually entered by the user. 001-00-000351 

2. Printing: new fields have been introduced to the impedance table of the technical report 
(H1, H2, H3, H4, Er1, Er2, Er3, Er4, T1 C1, and CEr). 001-00-000351 

3. Printing: Field selections are now stored as a Field IDs, no longer as literal strings. This 
overcomes potential problems when the Speedstack language is switched 001-00-000395 

4. Printing: The RCC material was not always rendering correctly on the overview page 
(copper was sometimes drawing on top of the dielectric - positioning problem). This has 
now been resolved. 001-00-000388 

5. Virtual Material Mode / Simple Percentage Method conflict. A warning dialog has been 
added to Speedstack if Virtual Material Mode AND Simple Percentage Method are 
selected. 001-00-000392 

6. Controlled Impedance Structures. When parameters are keyed in manually, the previously 
calculated result is cleared and a visual indicator is shown to highlight that recalculation is 
required. 001-00-000404 

7. Export to CSV: Fixed issue with RCC materials that caused the Export to CSV to throw an 
exception. 001-00-000388 

8. Structure Index control: The "All"/"L:1" button now reverts to "L:<layer selected>" after 
adding structures. 001-00-000395 
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9. Hatch profile: Resolved problem when hatch pitch / width is beyond the limits of the track 
bar (1 - 40 mils). An exception error was sometimes displayed in previous versions of 
Speedstack. 001-00-000398 

10. Mouse over stack up data columns now shows the correct field name on lower-left status 
bar panel. 001-00-000405 

Version 13.03 

Features 

1. User Interface Enhancements 
a. A new Process Thickness field is now available as a Display Field shown on the 

stack up graphic. Processed Thickness is the Finished Thickness for copper layers 
and Isolation Thickness for dielectric layers. 

b. A more consistent number accuracy (precision) is now used for the dielectric 
constant, isolation distance and finished thickness fields shown on the stack up 
graphic. 

c. Improvements to the impedance structure highlighting when Advanced Structures 
are used. 

d. Opening / saving of SCI project files is now given more emphasis than the older STK 
file format throughout Speedstack. 

e. Alterations have been made to the controlled impedance tab scroll bar behaviour to 
accommodate Simplified / Traditional Chinese and Korean Windows 7 OS. 
Previous versions of Speedstack running on these versions of Windows OS were 
not also able to access parameters at the foot of the parameter list. 

f. During start-up Speedstack will check if the screen resolution is below 1280 x 1024 
minimum specification and display appropriate warnings. 

g. The calculated impedance on the Controlled Impedance tab is now highlighted to 
make it stand out more than the other parameter fields. 

h. The Speedstack keyboard short-cuts have been reallocated to more Windows-like 
functionality. Short-cuts that originally use the Insert key have been changed to 
more suitable keys in order to support Apple keyboards. 

2. DRC Enhancements 

a. A new drill aspect ratio check for mechanical drills has been introduced. 
3. Printing Enhancements 

a. The selected Units are now printed on the title bar of the report. 
b. The print preview refresh issue when .Net Framework 1.1 was missing from the OS 

has now been resolved. 
c. Improvements have been introduced to the way RCCs are now printed. 
d. The dimension arrow line next to the stack up now finishes on the correct layer of 

the stack up image. 
4. Stackup Thickness Enhancements 

a. A new Solder Mask Thickness calculation has been added to the Stackup 
Information data grid 

b. A new stackup Thickness with Solder Mask calculation has been added to the 
Stackup Information data grid 

c. The presentation of the Stackup Information data grid has been improved to more 
clearly present the data 

d. A single Stackup Thickness definition is now used throughout Speedstack 
e. The main application status bar has been updated to include Target Stackup 

Thickness, Stackup Thickness and Stack Up Thickness with Solder Mask 

f. The print option now includes the Solder Mask Thickness and Stackup Thickness 
with Solder Mask calculations 
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5. Interfacing with other systems 
a. Speedstack is now able to load an XML file on launch. If an XML file (.stkx) filename 

parameter is specified on the command line it will import this file into Speedstack 
b. It is now possible to call an external program / utility / script from within Speedstack 

via the new External Utilities menu options. The menu items are configured within 
the Configuration option. 

6. Multiple instances of Speedstack 
a. It is now possible to start two or more instances of the Speedstack application. This 

is useful for stack up file comparisons and copying impedance structure parameters 
between stack up files. 

7. Licensing 
a. License change. Speedstack 2013 v1 3.03 requires a new FLEXlm license feature. 
b. A new SPEEDSTACK_IO license feature is used to secure the use of the Import / 

Export options. 

Fixes 

1. The Hatch Copper Percentage field now stores correctly within the Configuration option. 
001-00-000362 

Version 12.08 

Features 

1. UI: New Scrolling method by direct manipulation of the stack graphics 
a. Mouse Wheel to zoom in and out 
b. Default view is the maximum zoom achievable (100%) 
c. clicking middle (wheel) button jumps view back to default view (100%) with the first layer 

shown (when no layer is selected, otherwise selected layer is shown) 
d. clicking middle (wheel) button with CTRL held down, displays extents of the current 

stack 
e. left button held down on the view will allow for the stack to be scrolled up and down 

2. UI: Old Track/Scrollbar removed 
3. UI: Ability to zoom out and view larger stacks in their entirely 
4. UI: Red Indicator on layers that contain structures 
5. UI: References to 'Flex' now removed from menu 

6. UI: When Clicking 'New', a warning will appear that all data is about to be lost 
7. Code: All references to VIEWER now gone. Viewer no longer exists. 
8. Printing : Option to make grouping (by layer) of structures more obvious in CI table 
9. Printing : Ability to hide Board Thickness and Arrow-line 

Fixes 
1. UI: Disabled 'Remove Copper' for Foil types. 001-00-000266 
2. UI: Fixed issue when adding structure, Advanced button is clicked, Reference Layer 

changed, but is wrong if structure type is changed. 001-00-000280 

3. UI: Wizard Cancel button now working. 001-00-000261 
4. UI: Skip Button now hidden when viewing File-Properties. 001-00-000277 
5. Printing: Fixed problem where the Thickness line overshooting the extents of the stack. 

001-00-000282 
6. Printing: Fixed some drawing issues. 439-01-000267 
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Version 12.05 

Features 
1. HDI: Added functionality to the Navigator to improve support for HDI builds 
2. HDI: New option to copy valid drills from Master stack. 
3. HDI: Sequential Plan: Creates sub-stacks that represents each press cycle in a sequential 

lamination from Master stack based on foil locations 

4. HDI: Drill Plan: Creates sub-stacks that represents each press cycle from Master stack 
based on drill start-end layers 

5. HDI: Added the ability to create a sub-stack from the current stack selected rather than 
always creating a duplicate of the Master 

6. HDI: Added the ability to copy / paste an existing stack 
7. Error checking for unrealistic parameter values in VMM wizard 
8. Added a cancel option when exiting Library 
9. Display indication of whether user is in Material Library or VMM mode on main Editor 

screen 
10. URL position changed to avoid clashing with long copyright notices in Printing. 
11. Added the ability to import the stackup notes from an ascii file 
12. Renamed Speedflex HDI module to Speedstack Flex / Speedstack HDI 
13. Updated Configuration | Licensing tab 
14. Updated splash screen 

Fixes 

1. UI: Stop stack from scrolling to the bottom layer each time after changes are made 
2. UI: Most recently added structure is now the one in focus when the structure wizard is 

closed (001-00-000212 & 001-00-000235) 
4. Printing: Improved the way custom logo images are scaled 
5. Printing: Fixed a problem where the dimension arrows are incorrect for large stacks that 

span multiple pages 
6. Printing: Fixed blank pages being printed when all tables (stack, drills, impedance) are 

suppressed 
7. Printing: Fixed a problem where changing print parameters does not force a refresh when 

using Win 7 64-bit. 
8. File I/O: Fixed a problem where V1 2.01 does not open .stk files created in v11 .06 (001-00- 

000207) 
9. UI: Fixed 'F4' toggle for Nav view not working if Navigator has focus 
10. UI: Fixed problem where The 'View | Open Flex Nav' menu item checkbox does not reflect 

proper state when the Navigator is closed from the context menu 
11. License agreement: Updated license agreement 
12. Material library: Fixed tolerance field bug when Importing CSV for soldermask, ident and 

coverlay (001-00-000227) 
13. VMM Sequential/HDI wizard: Fixed bug where Core | Lower Trace | Trace Inverted flag set 

incorrectly (001-00-000230) 
14. UI: Fixed bug where highlighted selected structure not always appearing correctly 
15. File I/O: Fixed bug where Stackup File Properties lost during export to XML. (438-01- 

000036) 
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Version 12.01 

Features 
1. Crosshatch support for Speedstack / Speedflex (XFE). Implements the same crosshatch 

calculation technique used in the Si8000m / Si9000e 
2. Enhanced copy / paste structure exchange format (clipboard) to support hatch profile. 

Hatch Pitch, Hatch Width, Lower and 
3. Upper Hatch Plane flags are now transferred between Si8000m / Si9000e and 

Speedstack 

4. Apply Finishing tool bar icon now indicates that finishing has been applied 
5. Introduce the ability to override the materials colours when printing stack up documents 

using the technical report 
6. Improvements to the stack up dimension arrows on the technical report 
7. Virtual Material Mode wizard dialog improved 

Fixes 
1. Issue with Coplanar Strip 2B structures (without Ground) 
2. Minor problem when adding structures with no target impedance 

3. Undo / Redo now supports the addition of sub-stacks 
4. Importing XML files without structure information sometimes caused an exception 
5. Issue with Export / Import of XML files containing Flex Cores 
6. Issue with Export / Import of Peelable libary materials to CSV 
7. Issue with Coverlays in old sci/stk files causing exceptions 

Version 11.06 

Features 

Speedstack 

1. Definable colours per material 
a. Have the ability to set and store individual material colours, accessible from the 

material Properties dialog. When adding a material, the colour is set to the 
configuration defaults. Stacks loaded from previous Speedstack versions that do 
notcontain colour information will be set to the configuration defaults. Printing will 
reflect the colour changes 

2. Stack browser / search option 
a. Utilise alternate data streams (ADS) to store summary stack information, including 

layer count, thickness, copper thickness etc. A search mechanism is provided to 
allow the user to specify a filter criteria and match the relevant files. On selecting 
the file it will automatically load it into the stack editor 

3. Silver Paste support 
a. Reuse the foil material to represent silver paste, displayed in silver colour 

Speedflex HDI 

1. Configurable sub-stack display order 
a. The ability to re-arrange sub-stack order within Navigator now exits. The is useful 

for HDI builds 
2. Internal Coverlays 

a. Enhanced rules now allow impedance structures to be added when coverlays exist 
internally within stack. When a coverlay is beyond the outer copper it will behave 
like a coating, whereas when internal it will behave like a bondply / prepreg 
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3. Doublets 
a. Support situations where two or more flexi cores are present with an air gap in 

between 
4. Remove copper from sub-stacks 

a. Support situations where copper is removed from one side of a core in the sub- 
stack. Eg. the core has both coppers enabled in the Master but one copper is 
etched away in the sub-stack. 

5. Other Speedflex HDI Improvements 
a. Now includes the ability to rename substacks 
b. Sub-stack name now printed beneath each stack on technical print overview page 

Fixes 

1. Numerous fixes addressing known problems in previous version 
2. Increased stability 

Version 11.01 

Features 
1. Improved Autostack algorithm 
2. Improved Stack Re-Process Option 

3. Simplified GUI for AutoStack 
4. New style laser drilling 
5. New fill types for drilling (None, Copper, Resin, Soldermask) 
6. New Printing Features (Graphical additions, Drill table) 
7. Additional Note fields for Impedance structures 

Fixes 
1. Fixed cause of exception when importing XML with no structures when Project 

with structures loaded Ticket(325-01 -000770) 
2. Adding pre-pregs when in Simple Percentage Method now accepts Isolation 

Distance Settings Ticket 325-01-000775 
3. Bug importing from XML Mixed Layers with Differential impedances which results 

in Coplanars is fixed Ticket 325-01-000771 
4. Removed need to recalculate all structures on loading 409-01-000022 
6. Fixed Undo/Redo problem with Flex substacks 439-01-000007 
7. Fixed numerous reported/unreported bugs with AutoStack 325-01-000397,  

325-01-000406, 325-01-000408, 325-01-000506, 325-01-000680, 325-01-000725 
8. Fixed problem with finishing when switching Virtual Material Mode 325-01 -000897 
9. Fixed problem with loss of structures when no Ground present 325-01-000896 
10. Fixed exception when switching from AutoStack to Stack Editor when flex stack 

present 325-01-000889 
11. Fixed exception when removing sub-stack from stacks containing SSCs 325-01-000860 
12. 325-01-000808 

13. 325-01-000819 
14. Fixed problems with Single sided coppers 325-01-000831, 325-01-000853 and 325-01 

- 000888 
15. Fixed exception thrown under some circumstances when adding a letter to number 

boxes 325-01-000868 
16. Fixed exception thrown when switching from AutoStack to Stack Editor when there 

are fewer structures in the previous Stack 325-01-000871 
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Version 10.06 

Features 

1. Speedstack Express 

2. Different LayerTypes across sub-stacks, including no copper 

Fixes 
1. Loss of amended data when changing structure parameters then Refreshing (325-01- 

000682) 

2. On Leaving Flex Navigator Focus returns to frmStackUp (325-01-000633) 
3. Stack Reprocess causes exception when no licence present(325-01-000664) 
4. Incorrect Reference layers when Flexy Cores present(325-01-000665) 
5. Mirrored structures not working correctly when FlexiCore present (325-01-000666) 
6. Excess Resin now unit switching correctly (325-01-000675) 
7. Layer type buttons now functioning correctly (409-01-000003) 
8. Property form titles in correct(325-01-000655) 
9. Problems with Single Sided and Double sided core swaps(325-01-000704)(325-01-000643) 
10. Prevented the Enabling/Disabling of materials in Master Stack. Many bugs appear to 

originate in the disabling of materials in the Master stack (325-01-000608) (325-
01 -000630)(325-01 -000631 )(325-01 -000659)(325-01 -000698) 

11. Upper core having copper inverted when working in Symmetry(325-01-000722) 
12. Improved performance of Default File Folder, When Opening a Stack/Project the 

Default folder is pointed to. 
a. When Saving/Saving As a Stack/Project the source folder is pointed to. 

(325-01-000636) 
13. Symmetry Check Not working (325-01-000738) 
14. Prevent the removal or addition of Coppers while substacks present (325-01-000739) 

15. Test the validity of stacks before doing a Rebuild (325-01-000740) 
16. Fix problem with UndoRedo/ with Substacks present (325-01-000737) 

Version 10.01 

Features 
1. New Speedflex licensed module offering rigid flex support 
2. Additional flexible core, bondply and adhesive materials 
3. Navigator view that provides an overview of the rigid flex assembly, offering options to add, 

remove and select sub-stacks 
4. Printing enhanced to provide an rigid flex assembly overview, plus detailed reports for each 

sub-stack 
5. Laser drilling rules enhanced to allow drills to span several layers, with an associated 

facility in Configuration Options to specify maximum laser drilled layers 

Fixes 

1. Advanced structures now prevent the mis-specifying of plane layers 
2. When using Autostack, if the Filters folder has been removed, or incorrectly set, an error 

could occur. This has now been resolved. 
3. When using a single-sided core an error was reported when changing layer types. Fixed. 
4. When selecting coated coplanar structure a calculation issue sometimes occurred, fixed 
5. The Separation Region Dielectric (REr) parameter is now included in the XML export  
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Version 9.04 

Features 

1. Stack Editor. Option to change layer type from Signal or Plane to Mixed without removing 
structures. 

2. Impedance Summary. Add a new tab alongside the Controlled Impedance option to 
produce a summary of impedance structure status. Provides an overview without having to 
examine all structures individually. 

3. Material Library. Add option to sort columns. Add option to apply filters within library dialog 
4. Copper Finishing. For Laser vias only apply copper finishing to the first electrical layer only. 

5. Drilling. For mechanical drills remove "invalid drill" rules that prevent controlled depth drill 
passes from being added to stack. In summary, it should be possible to add a drill from an 
external to any internal layer 

6. Autostack. Multiple algorithm enhancements 
7. Configuration. Some legacy configuration fields exist for Print Technical Report A which 

should be removed to avoid confusion. 
8. Tech report. PTH and NPTH mechanical drill holes look very similar on the print out. 

Change the printed appearance of the NPTH hole so that it is more obvious to the user. 
9. Tech report has no indication on it that it came from Polar. Introduce a "strapline" that is 

always printed. 

Fixes 

1. Auto-loading an ssd file that has been deleted allows user to access auto-generate. This 
can then cause the software to through an exception error. 

2. When causing a design logic DRC error by moving solder mask down within stack a 
exception error is sometimes thrown when using Undo. 

3. Material Library Import. The RCC sample file included in the  
C:\Program Files\Polar\Speedstack\Material Library Import\M M folder is invalid. 

4. When using the Stack Wizard moving the mouse over the help icons causes the help tool 
tip to appear but they do not close 

5. Autostack. Resolve issue identified with broadside structures 
6. Reprocess stack sometimes causes solder mask to disappear when using Edit - 

Sequential/HDI option. 
8. Overcome form multilingual problems that sometimes occur within the AutoStack feature. 
9. Tolerance truncation problem. Within the library it is possible to enter a tolerance as a 

decimal, but when it is placed into the stack it is truncated to an integer. 
10. Remove tolerance field from non-dielectric materials. 

Version 9.01.01 

Features 
1. Coplanars now permissible on Mixed layers 
2. Job file import now remembers the definitions 

3. Increased graphics precision 
4. Warning message when clearing library 
5. Impedance structures ordered for printing 

Fixes 

1. Fixed Lock up state when impossible rules/materials included. 
2. Fixed Infinity thickness in coverlay graphics 
3. Fixed zero Tolerance in Properties (again) 
4. Fixed exception when deleting current constraint 
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Version 9.01 

Features 
1. Partial Stack Definition in AutoGen 
2. Rules for Dielectrics 
3. Laser Drill Rules 
4. Stack Padding to achieve overall board thickness 
5. "Mouse Over" stack wizard help 
6. Drill validation checks 
7. Preferred core can now be switched off 

Fixes 

1. Numbering of layers on stack review screen now correct 
2. Unbalanced coppers now detected in DRC checks 
3. Exception no longer caused when trying to launch with deleted ssd file 
4. Unit switching for drill sizes now correct 
5. Tolerance now visible in Properties 
6. Exception when loading old libraries now fixed 

Version 3.25 

Features 
1. UCAM .Job Import 
2. Convert 2 Foils to a Core 
3. Symmetrical Add Drill 
4. Symmetrical Move Material 
5. Symmetrical Delete 
6. Increase Resolution of tolerances 
7. Printing – New data column 'Processed Thickness' 
8. Printing – Impedance table columns now customisable 
9. Printing – New look Laser drills 
10. Printing – 'Trace 1 In Layer' renamed to 'Impedance Signal Layer' (to avoid confusion) 
11. Printing – 'Trace 2 In Layer' renamed to 'Broadside 2nd Layer' (to avoid confusion) 
12. Printing – Thickness data beside the stack image can now toggle between Actual and 

Target 

Fixes 
1. Exception Thrown when installing project on some continental machines 
2. Unit switching being carried out on Upper copper coverage in Selected items information 
3. Filtering option with Swap material 
4. Comma related problem with Czech Windows 
5. Copper coverage percentage on upper copper seems to unit switch 
6. Printing – problem with the thickness data & line (beside the stack image resolved for 

stacks with non-copper core or single-sided cores 

Version 3.2 

Features 
1. All Structures available on Mixed layers 
2. Unit Switching 
3. Undo/Redo 
4. Add Drills to Auto-generate files. 
5. Extend dielectric constant threshold. 
6. Export Material Library to CSV 
7. Export To Coupon Generator 
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Fixes 
1. Autogenerate will now accept copper with 0 weight present in Library 
2. Update Er when default value changed 
3. Highlighting copper types required to make changing of copper types possible 
4. Improve final finished height when Auto generating 
5. Defaults disabled in Defaults screen once stack initialised 
6. Prevent exception thrown when in Structure wizard 
7. Make tolerances more intuitive in Autostack 
8. Si9000e License now being "formally" released 
9. Prevent exception being thrown when importing a stack with no structures 

Version 3.0 

Features 
1. Add/Swap Non-copper cores 
2. Re-engineer existing stacks 
3. New auto-generate GUI 
4. Add Drills to Auto-generate files. 
5. Automatic adjustment of impedance and or trace width when goal-seeking to increase 

the chances of achieving a working stack. 
6. One-click selection of material for use in auto-generate by means of filters 
7. HDI and Sequentially laminated stacks now catered for. 
8. Removed Soldermask from Thickness calculations 

Fixes 

1. Highlighted Errors reset when scrolling through Structures 

2. Board thickness error reset when board thickness changes or when DRC switched off 

3. When manually building a stack an exception error occurred whilst adding materials 
4. When Excess Resin check selected warning about requiring Excess Resin Fields to 

be populated occurs when launching app 
5. When symmetrical mode is turned on and editing the copper coverage say on a core, the 

copper coverage of the corresponding symmetrical layer is automatically set to 0. 
However, it should ideally be set to the same value or left untouched. 

6. Max and min impedance values are reversed on some dialogues 
7. Column selection dialog found in materials library and Printing B 

Version 2.2 

Fixes 

1. Possibility of adding a broadside structure to a layer that does not contain a core pair. 
2. Separation incorrectly spelled. 
3. Column selection dialog; when ‘Down’ button is pressed with no selection made – 

exception is caused. 
4. Minimum Allowable Hole Size calculation does not take into account the copper thickness 

of the exit layer. 
5. Symmetry makes some auto-generated builds impossible these were not being handled. 

6. Changing default thickness does not take effect until after closing and restarting Application 
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Version 2.1.2 

Fixes 
1. Cores with copper etched off not showing up in print. 

Version 2.1.1 

Minor Fixes 
1. Inability to Load .ssd files without soldermasks 
2. Problem with core only H1 values where there is more than 1 core for embedded structures 
3. Prevent continued Goalseeking when Auto-generate already failed 

4. Ensure Max and Min values correctly displayed in Summary form 
5. Issues with saving project files 

Version 2.1 

Minor Fixes 

1. Editing exception fixed 

Version 2.0 

Features 

1. Ability to auto generate stacks with no dielectric height information 
2. New material library field for cores: Plane on Both Sides 

Minor Fixes 

1. When using the mirror function, the extra note fields are now copied correctly 
2. Missing drills from Report B printout missing when layers are mixed 
3. Report B printout footer readjusted 
4. Report B printout now displays a page total 
5. Report B printout thickness data repositioned 

Version 1.5 

Features 

1. New material fields/properties added: 
a .  Cost 
b .  Lead Time 

c .  5 x Notes 

d .  Panel Size 
2. New Stack fields/properties added: 

a. 4 x Revision slots 
i. Revision 

ii. Modification 
iii. Date 

iv. Editor 
3. Updated CSV Export 
4. Updated XML Export 
5. Updated Materials Library Import 
6. New, customisable print output 
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Minor Fixes 

1. Impossible build is now flagged when plating copper, finishing resulting in a negative value 
for isolation distance 

2. Shortcut key CTRL+SHIFT+B bug fixed 
3. Add CI Structure in the main menu bug fixed 
4. Switching copper core planes to mixed exception fixed 

Version 1.1 

Features 

1. New algorithms to allow more emphasis on cost than accuracy of the builds 
a. Library templates allow for Cost, Lead-time etc. 
b. Visual tweaks 
c. Controlled Impedance information now added to XML outputs 

Minor Fixes 

1. Symmetry bugs fixed 
2. Persistent DRC via error bug when DRC is turned off fixed 
3. Mixed units bug fixed 
4. Printing showing different isolation distance than to what is on screen fixed 
5. Saving ssd file issue fixed 
6. Export issues fixed 
7. Missing CI. Indices from print-out fixed 

Version 1.0 Release 


